
MHA Data Submission Guide

For MIDB/MODB

Publish Date:  December 17, 2003
This document is updated periodically.  If you are not
reading this on the web but are instead reading a printed
copy, please check our web site to ensure that you have
the latest copy.  Up-to-date information can be found at:
http://www.mhaservicecorp.com/data/midb.asp.  You
may also call Data Services at (517) 886-8448 for
verification.
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INTRODUCTION

Hospitals submit discharge abstracts to the Michigan Health & Hospital Association (MHA) for

inclusion in the Michigan Inpatient Data Base (MIDB) and the Michigan Outpatient Data Base

(MODB).  The MHA uses this data for policy and advocacy purposes including policy

development, research, education, communicating the hospital perspective to business and

government, and for dialogue with other organizations.  The MHA also supplies the Michigan

Department of Community Health with this data.  Hospital administrators and staff use these two

databases via the Interactive Data System (IDS), a computerized database management system

developed by the MHA Service Corporation, for planning, program development, and quality

assessment.

It is the responsibility of Data Services, within the Michigan Health & Hospital Association

Service Corporation (MHASC), to collect hospital inpatient data for the MIDB and selected

outpatient data for the MODB.  This Data Transmission Guide provides hospitals with a

reference document to aid in data transmissions.

By following the data submission criteria outlined in this document, you will be helping the Data

Services staff to process your data more quickly and accurately.

Companion Documents

 The following companion documents should also be consulted to gain a full understanding of the

requirements for submission of data to the MIDB/MODB:

Format Specifications for the MHA 1400

MHA Data Packager
 
 Both documents can be accessed at:  http://www.mhaservicecorp.com/data/midb.asp.
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DATA PROCESSING CYCLE

The data sent for inclusion in either the MIDB or MODB is reviewed extensively by several

people both at MHA and at the submitting facility.  Reports are generated to provide comparison

data for many categories such as disposition (discharge status), principal or secondary pay

source, and admission source.  In addition, listings are generated for invalid or missing fields to

provide Health Information Management (HIM) staff the opportunity to correct the data before

inclusion in the final MIDB or MODB.

To accomplish this, MHA relies on hospital staff to work cooperatively with the assigned MHA

Data Quality Representative to assure the most accurate and complete data possible.  Listed

below is a brief summary of the steps taken by MHA and the facility to prepare data for inclusion

in the MIDB and/or the MODB.

1. The facility compiles the data into an MHA-defined format called the MHA 1400.
Detailed specifications for this format can be viewed at
www.mhaservicecorp.com/data/midb.asp.

2. The submission is sent to MHA on a quarterly basis using the various methods that are
outlined in this manual. Data submission deadlines are published at
www.mhaservicecorp.com/data/midb.asp.

3. An MHA Data Quality Representative sends a data quality letter to the designated
hospital contact outlining the questions or concerns with the data submission.

4. If the submitted data does not pass review, an MHA Data Quality Representative works
with the designated hospital contact, usually HIM staff, to facilitate the correction of
problems.

5. When the data passes review, it is submitted to the Client Services division of MHASC
Data Services for final approval.

After Client Services approves the submission, the data is made available to IDS clients on a

quarterly basis.  However, access to data is allowed only if the facility has submitted their

quarterly data by deadline, so it is very important that all staff involved in the data processing

cycle stay on target.  Early access to data is important to clients.  In addition to quarterly data,

calendar-year databases are made available in May and November of each year.  For example,

Preliminary 2002 data is available in May of 2003 and Final 2002 data is available in November

2003.
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DATA SPECIFICATIONS

MHA expects hospitals to submit data in the MHA 1400 format.  MHA 1400 format

specifications and updates are published at www.mhaservicecorp.com/data/midb.asp.

PROCESSING PROCEDURES FOR SYSTEM OR FORMAT CHANGES

If you are changing submission formats or modifying extraction programs (done when a facility

undergoes a systems conversion), make certain that the file is formatted according to the

current MHA 1400 specifications.  Do not convert to a legacy format.  Once the facility has

completed the programming changes, the facility will be placed into a testing phase.  The test

cycle can take from two weeks to six months, or longer, depending on the quality of the

programming and the ability of the hospital to dedicate resources to the project.  We recommend

that you plan on getting test data to us well before any established deadline so that there is plenty

of time to pass out of test.

Processing Procedures:

1. The facility compiles the data into the current MHA 1400 format.  (See MHA 1400
format specifications and updates at www.mhaservicecorp.com/data/midb.asp.)

2. The best test file is a sample (full month or full quarter) of previous year’s data which we
processed under the old format, or before the extraction program changed.  MHA can
then run direct comparisons on the data.

3. Notify the MHA Data Quality Representative at 517-886-8328 of the impending test
cycle.  MHA will need the name, phone number, and e-mail address of the contact person
(often a programmer) who will be working with us during the test cycle.

4. The submission is sent to MHA via Data Packager, diskette/CD, or the bulletin board
system.

5. The Data Quality Representative will examine your submitted data and then contact the
programmer to discuss any problems identified.

6. Correction and resubmission will occur until both parties agree that the data extraction
programming is accurate.

7. Once the programming has been validated, the submission is forward to the MHASC
Client Services division of Data Services.

8. MHASC Client Services staff will conduct their own review and will direct the Data
Quality Representative to follow-up with your facility if they identify any data issues.

9. Once all data issues have been resolved, the Data Quality Representative will contact
your hospital that MHA is ready to pass you out of test.

10. Once the client contact in your hospital approves, then you will be notified that you can
send production data.
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DATA SUBMISSION CONSIDERATIONS

It is important to keep in mind that the arrival of your data at MHA signals the beginning of a

quality review cycle between MHA Data Services and your facility.  Although you will

technically meet deadline requirements if MHA receives your data the day before the cut-off

date, sending the data too close to a deadline severely shortens the time available for both

yourself and/or the facility’s HIM staff to respond to quality issues.

MHA normally works on an ongoing basis with your HIM staff to correct data problems.  These

problems can range from a small number of invalid zip codes to a large number of missing

dispositions or diagnoses.  When the volume of problems is low, HIM staff will return edit

reports to MHA with the corrections indicated.  MHA Data Services staff then enters the

corrections with no further submissions by the programmer/Information System Department.

However, if the volume of problems is high, the data (or programs) will need to be corrected at

the hospital.  This will require the data to be re-extracted and resent to MHA.

MHA and the hospital proceed with this continuous review/response until the data is acceptable.

If the data is not received early enough everyone, including the IS staff, has a very limited

amount of time to respond to problems.

Conversely, if data is sent too early, many of the problems uncovered are the result of incomplete

records.

MHA recommends that you submit data on a quarterly basis, but only after HIM has closed

that quarter.

Experience indicates that the lag time for closing records varies between hospitals.  It is

recommended that you coordinate with your HIM staff to determine the best time for data

extraction.
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DATA SUBMISSION DEADLINES

Submission deadlines are determined every year, so please check the current schedule.

Schedules are published at www.mhaservicecorp.com/data/midb.asp.

DATA TRANSMISSION SPECIFICATIONS

The following media are acceptable for submitting your data to MHASC, Data Services:

• MHA Data Packager Program
• Electronic Submission
• 3 ½ Diskette or Zip Disk or CD

MHA Data Packager:

MHA Data Services has developed a product called MHA Data Packager to send data

submissions easily and securely using the Internet.  To obtain a copy of this program, please

contact the Data Services Secretary at (517) 886-8327.  The MHA Data Packager User Guide

can be viewed at www.mhaservicecorp.com/data/midb.asp.  For more information on the

encryption algorithm used by the MHA Data Packager program, you can visit the Bruce Schneier

Blowfish site at: http://www.schneier.com/blowfish.html.

Electronic Submission:

The Bulletin Board System (BBS) is available 24 hours a day.  However, during normal working

hours (Monday-Friday, 8 to 5 p.m.) it may occasionally be busy.  To send electronically, our

modem number is (517) 323-2226.

http://www.schneier.com/blowfish.html
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Using the Bulletin Board

The following is a copy of the screen you will be using once you have made contact with the

MHA computer. Included are a few brief instructions that are italicized.

Welcome to MHASC Data Services Host!

Enter your full name: Please use your name not your hospital name.

Is this correct (Y/N)? If correct enter Y, if not enter N.

Password: Please use something you can remember. You will need to use the same password if
you try to reconnect to our system later.

F)iles U)pload D)ownload
H)elp T)ime C)hat
R)ead Mail L)eave Mail G)oodbye

Your Choice? Enter a U for Upload

A) Ascii Y) Ymodem (Batch)  S) Sealink
K) Kermit O) 1K-Xmodem  T) Telink
X) Xmodem E)1K-Xmodem-G W) Wxmodem
Z) Zmodem G) Ymodem-G (Batch)   I) Imodem

Your Choice?  Please note, if you  use Y or Z  you will not be able to rename your file (i.e.
whatever you originally named your file, that is the file name that will be sent).

File Name?  Please use the following naming conventions: Use your 4-digit hospital ID, the date
range and the extension of INP for inpatient, OUT for outpatient, and BTH for both inpatient
and outpatient records.

Example: Hospital ID is 9999, you are submitting Jan thru June 1996, and it is Inpatient. You
would enter 99990106.INP.

Begin your MODEM transfer procedure... (CTRL-X aborts) At this point your communications
software takes over and will ask you for your file name. When finished sending, you will see:
TRANSFER COMPLETE

F)iles U)pload D)ownload
H)elp T)ime C)hat
R)ead Mail L)eave Mail G)oodbye

Your Choice? Enter U if you have more files to send or G to quit.
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Modem Troubleshooter

This troubleshooter will help you identify and solve modem problems if you are using

HyperTerminal. HyperTerminal also has a troubleshooting guide that can be accessed thorough

the Help window.

Problem: The number is not being dialed at all.

1. Make sure a cable connects your communications port and modem and that your modem

is plugged into the phone jack.

2. Try the call again.

Problem: File transfer either doesn't work or is slow.

If other people are using the remote computer, it may run more slowly. Try again later when

fewer people may be connected to the remote computer. If this is not the case, MHA suggests

you check that the transfer protocol you are using is the same as the remote computer.

1. On the Transfer menu, click Send File.

2. Make sure the transfer protocol you are using is the same one the remote computer is

using.

3. Try to send the file again.
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Dial-Up Networking Troubleshooter

This troubleshooter will help you identify and solve problems with Dial-Up Networking.

1. I can connect to the remote computer, but I do not see a terminal screen.
a. If using SLIP or PPP:

 i. In the Dial-Up Networking window, click the connection you are creating
a terminal screen for.

 ii. On the File menu, click Properties.
 iii. Click Configure.
 iv. Click the Options tab, and then make sure Bring Up Terminal Window

After Dialing is checked.
 v. Try your call again.

b. If using Windows:
 i. Dial-Up Networking doesn't show a terminal screen. Use Connect

Network Drive to gain access to shared files and folders on the remote
computer.

2. I can connect to the remote computer, but the remote computer hangs up right after
answering the phone.

a. In the Dial-Up Networking window, click the connection you are creating a
terminal screen for.

b. On the File menu, click Properties.
c. Click Configure.
d. Click the Options tab, and then make sure Bring Up Terminal Window After

Dialing is checked.
e. Try your call again.

3. Dialing doesn't work correctly.
a. Make sure a cable connects your communications port and modem and that your

modem is plugged into the phone jack.
b. Try the call again.

4. The remote computer hangs up unexpectedly.
a. You may be experiencing line noise or cable problems. Try your call again.
b. You may have gone too long without typing anything, or your account may limit

how long you can be connected to the computer. Try the call again, and ask the
administrator for the remote computer whether your time limit can be increased.
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Diskette/CD:

If you would like to submit your data on a 3-½ diskette or CD, please follow the guidelines

below:

1. The diskettes must be IBM formatted.
2. The files must be Windows compatible.
3. We accept uncompressed files, WINZIP, or compressed files that are self-exploding.

After copying your data to diskette or CD, you will need to affix an appropriate label.  Please

make certain that the label contains the following information:

Date Rec’d:_______ Sub #:________
MHA Service Corporation
Hospital Name:__________________
Data Year:______________________
Month(s) Submitted:______________
Number of Records:______________
Contact Person:__________________
Record Length:__________________
(   ) Outpatient  (  ) Inpatient  (  ) Test

Please leave “Date Rec’d” and “Sub #” blank as they are items that your MHA Data Quality

Representative needs to fill in when the diskette or CD arrives.  Please remember to check

Outpatient, Inpatient, or Test.

Once the diskette/CD is properly labeled, place it in an appropriate mailer and mail it to your

MHA Data Quality Representative for processing at the following address:

Data Services
Inpatient/Outpatient Data
MHA Service Corporation
6215 West St. Joseph Highway
Lansing, MI 48917

For your convenience, MHA will supply you with both diskette labels and mailing labels upon

request.  Simply contact the Data Services Secretary at 517-886-8327 to order labels.
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APPENDIX

Legacy Conversion Guide

All format conversions need to use the latest MHA 1400.  If you are converting from an earlier

version of the 1400, you will need to review individual field updates to determine if

programming changes are needed, but the same basic structure as earlier versions of the 1400 is

retained.  A very small number of Michigan hospitals have submitted data on the 175 Legacy

format.  We expect all hospitals to submit data on the MHA 1400 and encourage the remaining

hospitals to update to the 1400.  We have provided the following conversion tables to assist with

that.
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Conversion Table for 175 format

1400 Field Name Corresponding 175 Field & Position

Facility ID – MHA Assigned, Record position 8-15 Hospital; Record position 1-4
Patient Medical Record Number, Record position
16-24

MRN; Record position 5-13

Discharge Date, Record position 92-99 Dis-Date, Record position 14-19
Admission Date, Record position 84-91 ADM-Date, Record Position 20-25
Birthdate, Record position 64-71 Birth_date, Record Position 26-31
Patient Zip Code, Record position 75-79 Zip_code, Record Position 33 to 37
Gender, Record position 72 Sex, Record Position 38
Race, Record position 73 Race, Record Position 39
Admission Type, Record position 100 ADM-Type, Record Position 40
Hospital Service Code, Record position 896-897 SVC-Code, Record Position 41-42
Attending Physician Legacy, Record position 118-
122

Att-Phy, Record Position 43-47

Admission Diagnosis, Record position 144-148 Adm-Dx, Record Position 48-52
Principal Diagnosis-ICD-9, Record position 149-153 PDX, Record Position 53-57
Other Diagnosis-ICD-9, Record position 154-158 Addl-Dx1,Record Position 58-62
Other Diagnosis-ICD-9, Record Position 159-163 Addl-Dx2,Record Position 63-67
Other Diagnosis-ICD-9, Record Position 164-168 Addl-Dx3, Record Position 68-72
Other Diagnosis-ICD-9, Record Position 169-173 Addl-Dx4, Record Position 73-77
Other Diagnosis-ICD-9, Record Position 174-178 Addl-Dx5, Record Position 78-82
Other Diagnosis-ICD-9, Record Position 179-183 Addl-Dx6, Record Position 83-87
(23) Other Diagnoses-ICD-9, Record Positions 184-
298

[no corresponding fields]

Surgeon Legacy, Record position 131-135 SURGI-Surgeon from Edpisode 1, Record Position
88-92

Principal Procedure-ICD-9, Record position 299-302 Prin-Px, Record Position 93-96
Other ICD-9 Procedure, Record Position 309-312 Addl-Px1,Record Position 97-100
Other Procedure-ICD-9,, Record Position 319-322 Addl-Px2, Record Position 101-104
Other Procedure-ICD-9,, Record Position 329 to 332 Addl-Px3, Record Position 105-108
Other Procedure-ICD-9,, Record Position 339-342 Addl-Px4, Record Position 116-119
Other Procedure-ICD-9,, Record Position 349-352 Addl-Px5, Record Position 120-123
Other Procedure-ICD-9,, Record Position 359-362 Addl-Px6, Record Position 124-127
Other Procedure-ICD-9,, Record Position 369-372 Addl-Px7, Record Position 128-131
Other Procedure-ICD-9,, Record Position 379-382 Addl-Px8, Record Position 139-142
Other Procedure-ICD-9,, Record Position 389-392 Addl-Px9, Record Position 143-146
Other Procedure-ICD-9,, Record Position 399-402 Addl-Px10, Record Position 147-150
Other Procedure-ICD-9,, Record Position 409-412 Addl-Px11, Record Position 151-154
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1400 Field Name Corresponding 175 Field & Position

(18) Other Procedures-ICD-9, Record Positions 419-
592

[no corresponding fields]

Principal Procedure Tissue, Record Position 904 Tissue, Record Position 157
ICU Used, Record Position 898
ICU Days, Record Position 899-900

ICU-Days, Record Position 158-159

CCU Used, Record Position 901
CCU Days, Record Position 902-903

CCU Days, Record Position 160-161

[SCU is no longer captured.  Map to ICU or CCU as
appropriate]

SCU-Days, Record Position 162-163

Principal Payer, Record Position 106-107 PPAY, Record Position 164
Secondary Payer, Record Position 108-109 SPAY, Record Position 165
Disposition (discharge status), Record Position 103-
104

Combination of Disp-Alive, Record Position 170
& Record Positions 48-51
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Patient Type Flag Location for 175 Legacy Format

If your facility has elected to send outpatient data but has not yet converted to the 1400 format,

the following patient type flag location is provided.

Format Field Name Position Inpatient
Flag

Outpatient Not
Observation

Outpatient
Observation

175 ADM_TYPE 40 9 8
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